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Lecture 6: Overview

* Project Discussion: Digital Camera

— Assignment 1: Sender/Receiver Example
Assignment 2: JPEG Application Structure
Assignment 3: Sequential SpecC Model
Assignment 4: Sequential SpecC Model in SCE
Assignment 5: Parallel SpecC Model for Synthesis
Discussion, Q&A

* Modeling of Hardware in SoC Design
— Hardware Modeling
— Register Transfer Level (RTL)
— Accellera RTL Semantics
* RTL Modeling in SpecC
- bit, bit4 bit-vector types
- buffered, signal type modifier
- fsmd statement
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Modeling

Project Discussion

+ Digital Camera Example
— Component Model

CCD S Flash

Sensor Memory
CCD pixel Jpeg bytes File
Control Encoder 1/0

JpegEncoder
Pixel Read ]ﬁfk{ DCT ]W{Quant]m’[ Huff bytes
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Project Discussion: Assignment 1

» Task: Introduction to SpecC Compiler and Simulator
— Become familiar with sce
* Seeman scc for manual page
— Use scc to compile and simulate the examples in
+ /opt/sce-20080601/examples/simple/
— Build and simulate the sender/receiver example
» See Slide 25! (behavior B should be Main)
« Sender s should send values 0.0, 0.5, ... 5.0
to the receiver R which prints them to the screen

* Deliverables

— Source file: SendReceive. sc
— Simulation log: SendReceive.log
* Due

— By next week: October 9, 2009, 12pm (noon)
— Email to doemer@uci.edu with subject
“EECS222A Assignment 1”
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Modeling

Project Discussion: Assignment 1

Add behavior Main

Add loop to s
Add loop to R

Compile and Simulate

interface IS

{

void Send(float) ;

}i

interface IR

{

float Receive (void) ;
}i

behavior S (IS Port)

channel C
implements IS, IR
{

float X; event Req;
Donel! void main(void) float Data;
t... event Ack;
Port.Send(X) ;
4 (o3 ) void Send(float X)
} { Data = X;
Main IS IR Li notify Req;

BE

behavior R (IR Port)
{

wait Ack;
}
float Receive (void)

float Y; float ¥
void main (void) { slens T
{ wait Req;
Y=Port.Receive () ; X :.Data;
notify Ack;
) e return Y;
G b8 )
}i
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Project Discussion: Assignment 2

+ Digital Camera Example
— Component Model

CCD SoC Flash

Sensor 4 cop Jpeg File Memory
1 Control Encoder /0

JpegEncoder
Pixel Read ]—;::b[ DCT ]—bf;o'fkb[ Quant ]—_j:jk#[ Huff bytes
k

— Homework Assigment 2

» Become familiar with JPEG Encoder Application

—Study reference code:
/home/doemer/EECS222A F09/jpegencoder.tar.gz

—Draw block diagram of files, functions, and key communication variables
—Simplify code for a 116x96 pixel CCD (eliminate malloc calls!)
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Modeling

Project Discussion: Assignment 3

Task

— Convert JPEG Encoder Application
to a proper SpecC Specification Model

Main

Stimulus JpegEncoder Monitor

ReadBmp() FileWrite()

Deliverables
— Email to doemer@uci.edu with subject
“EECS222A Assignment 3”
« Brief status description (in body of your email)
» Source code jpegencoder. tar.gz (attachment)
Due
— Next week: October 30, 2009, 12pm (noon)
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Project Discussion: Assignment 3

Hint:
— Use the sir_tree tool to validate your hierarchy
— The final model should look like this:

doemer@epsilon.eecs.uci.edu:3 > sir tree -blt digicam.sir
io behavior Main

| ====== JpegEncoder jpeg

| | emmmm= Dct dct

| | |-———-- Bound bound

| I |——==—-= ChenDct chendct

| I \-————= Preshift preshift

| | ====== Huff huff

| | | ====== Huffencode huffencode
| I \-===—= Zigzag zigzag

| | =====- Quantize quantize

| \-———-- ReadBlock readblock

| -==—==-- Monitor monitor

| —===== Stimulus stimulus

|ome=e= c_queue data

\-————- c_handshake start

QOO WwWwoweoweoweoweoweowowowoww
L T o o o o O !
HFHHHRKHKRHHFODHFHKFKF®BO
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EECS222A: SoC Description and

Modeling

Project Discussion: Assignment 4

3. Analyze your digital camera model in SCE
— Setup
» ...continued from step 2 (previous page)
— View the structural hierachy chart
» Select the Main behavior in the behavior browser
» Right-click ->Chart
» Double-click the chart to add further levels of hierarchy
e Turn on connectivity View->Connectivity
¢ Window->Print.. tofile “digicam.ps”
* In your shell window, convert the PostScript file to PDF:
ps2pdf digicam.ps
* Check the PDF file: acroread digicam.pdf
+ Deliverables
— Hierarchy chart
¢ “digicam.pdf”
* Due
— by Friday, Nov 6, 2009, at noon
— by email to doemerQuci.edu with subject “EECS222C HW4”
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Project Discussion: Assignment 4

» Sequential Digicam Model

— Screen shot of Hierarchy Chart in SCE
— (rotated by 90 degrees)

- jpegencoder?.tar.gz
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EECS222A: SoC Description and

Modeling

Project Discussion: Assignment 5

Create a parallel/pipelined and synthesizable Digicam model
— Start from previous model
+ /home/doemer/EECS222A F09/jpegencoder2.tar.gz
— Insert timing checks into the test bench
— Add explicit 1/0 units
— Parallelize/pipeline the JpegEncoder block
* Modify Dct, Quantize and Huf fman

to infinitely work on continuous streams of data
over typed queue channels

— Validate functionality
— Print hierarchy chart with connectivity

Deliverables

— Status description

— Source code “digicam. tar.gz”

— Hierarchy chart “digicam.pd£f”

Due

— by Friday, Nov 13, 2009, at noon

— by email to doemer@uci.edu with subject “EECS222C HW5”
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Project Discussion: Assignment 5

Pipelined
Digicam
Model

Explicit I/O Units
Explicit Pipelining
Communication
via Queues

jpegencoder3
.tar.gz
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EECS222A: SoC Description and

Modeling

Modeling of Hardware in SoC Design

* Hardware Modeling

— FSMD Model: Finite State Machine with Data
» Combined model for control and computation
» Implementation: controller plus datapath

©r) (v (©r9
2
©e) (2 @@

oy
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Modeling of Hardware in SoC Design

* Register Transfer Level (RTL) Modeling
— Block diagram of generic RTL component (high level)

Control Datapath
inputs inputs
Bommm e e
E Control
! signals
Control
it Status Datapath
uni signals
Control Datapath
outputs outputs
Source:

http://www.eda.org/alc-cwg/cwg-open.pdf
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EECS222A: SoC Description and

Modeling

Modeling of Hardware in SoC Design

* Register Transfer Level (RTL) Modeling

— Block diagram of generic RTL component (low level)

Control Dlatapath
inputs inputs

Rz Output

state .
logic

logic |—

State.

register

-------- > 4
™ \ALU fs 1

i

Bus3 |

i

i Controller l signal l Datapath
S P U ) SO PRI ENEUUIS UL
Control Datapath
outputs Source: outputs
http://www.eda.org/alc-cwg/cwg-open.pdf
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Modeling of Hardware in SoC Design

» Hardware Refinement (for each HW block)
Allocation of hardware components

» Type and number of functional units

* Type and number of storage units

» Type and number of interconnecting busses
Scheduling

* Representation of basic blocks as super-states

» Scheduling of operations to clock cycles
Binding

» Bind functional operations to functional units

» Bind variables to storage units

+ Bind transfers to busses
Result:

» Clock-cycle accurate HW model
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EECS222A: SoC Description and

Modeling

Modeling of Hardware in SoC Design

* RTL Modeling

— State modeling: Accellera RTL Semantics Standard
» Style 1: unmapped
- a=b * ¢c;
» Style 2: storage mapped
- Rl = Rl * RF2[4];
« Style 3: function mapped
- Rl = ALU1l(MULT, R1, RF2[4]);
» Style 4: connection mapped
- Busl = R1;
- Bus2 = RF2[4];
- Bus3 = ALUl (MULT, Busl, Bus2);

» Style 5: exposed control
- ALU CTRL = 011001b;
- RF2_CTRL = 010b;
- Source: http://www.eda.org/alc-cwg/cwg-open.pdf
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The SpecC Language

* RTL Modeling

— Types specific to RTL
«bit[l:r] two-value logic vector of arbitrary length
«bit4[1l:r] four-value logic vector of arbitrary length
— Type modifiers specific to RTL
- buffered Storage

* signal Communication
— Control flow specific to RTL
e fsmd Explicit finite state machine with datapath
EECS222A: SoC Description and Modeling, Lecture 7 (c) 2009 R. Doemer 18
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EECS222A: SoC Description and
Modeling

+ Bit vector type: bit

— signed or unsigned

— arbitrary length

— standard operators
* logical operations
+ arithmetic operations
* comparison operations
+ type conversion
* type promotion

— concatenation operator
*a @b

— slice operator
e afl:r]

EECS222A: SoC Description and Modeling, Lecture 7

The SpecC Language

typedef bit[7:0] byte; // type definition

byte a;
unsigned bit[16] b;

bit[31:0] BitMagic(bit[4] c,
{
bit[31:0] r;

= 11001100b; //
b = 1111000011110000ub; //
b[7:0] = a; //
b = d[31:16];
if (b[15]) //
b[15] = Ob; //
r =a @ d[11:0] @ ¢ //
@ 11110000b;
a = ~(a & 11110000Db) ; //
r += 42 + 3*a; //
return r;

}

bit[32] d)

constant
assignment

sliced access

single bit

access

concatenation

logical op.
arithmetic op.

(c) 2009 R. Doemer 19

— signed or unsigned

The SpecC Language

* Four-value bit vector type: bit4

— 4-value logic
1 (0q1) high
+ 0 (0q0) low
* X (0agx) unknown
ez (0az) high impedance

— arbitrary length
bit4[31:0] BitMagic(bit4[4] a, bit4[32] b)
— standard operators {
resolved bit4[31:0] r;
+ same as for
regular bit vectors a = 0q11001100;
. . b = 0g11110000zzzzxxXxx;
— resolution function r = 0xq01XZ;
* type modifier S
resolved )
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EECS222A: SoC Description and

Modeling

The SpecC Language

+ buffered type modifier

— Representation of storage in RTL models
* register
« register file
* memory

— Update at notification of specified events
« synchronized with explicit clock

event Clkl, Clk2; // system clock
buffered[Clkl] bit[32] RI1; // register
buffered[Clkl] bit[32] R2;

buffered[CLK2] bit[16] RF[64]; // register file
buffered[CLK2] bit[ 8] M1[1024]; // memory

Rl = R2; // swap contents of Rl and R2
R2 = R1;
wait CLK1;
RF[2] = RF[0] + RF[1];
wait CLK2;
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+ signal type modifier
— Representation of wires and busses in RTL models
— Semantics as in VHDL, Verilog
signal bit([31:0] addr; // address bus
signal bit[31:0] data; // data bus
buffered[CLK] M[1024];
wait addr; // memory read access
data = M[addr];
wait addr && data;
M[addr] = data; // memory write access
— Implemented as buffered variables with associated event
signal int x; < buffered int x v; event x e;
= = 55 & x_ v = 55; notify x e;
y =x + 2; &y =x v+ o2;
wait x; < wait x_e;
notify x; < notify x e;
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 RTL control flow
— f£smd construct

» Explicit states and state transitions

» Explicit clock specifier

— event list (external clock)

— time delay (internal clock)
* Explicit sensitivity list

— needed for Mealy machine support
» Explicit reset state

— synchronous reset

— asynchronous reset

EECS222A: SoC Description and Modeling, Lecture 7

The SpecC Language

+ Similar to £sm construct, but specifically for RTL

» State actions represent well-defined register transfers
— limited to conditional/unconditional assignments and function calls
— general loops, exceptions, synchronization, timing are not allowed

(c) 2009 R. Doemer

The SpecC Language

RTL behavior FSMD Example (
signal in bool CLK,
. signal in bool RST,
Modelmg signal in bit[31:0] Inport,
signal in bit[1] Start,
signal out bit[31:0] Outport,
Example signal out bit[1] Done)

{ wvoid main (void)
{
fsmd (CLK)
{
bit([32] a, b, ¢, d, e;

{ Outport = 0;

Sil g {a=Db+c;
d = Inport * e;
Outport = a;
goto S2;
}

}i

// system clock
// system reset
// input ports

// output ports

// clock + sensitivity

// local variables

// default
// assignments

// reset actions

Done = 0Ob;
}

if (RST) { goto SO;
}

SO : { if (Start) goto S1;
else goto SO;
}

// state actions

// (register transfers)

EECS222A: SoC Description and Modeling, Lecture 7
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EECS222A: SoC Description and
Modeling

The SpecC Language

RTL behavior FSMD Evamnle(
‘Qinna‘l in bool CTLK

tem cl k

sianal in bool RST

tem reset

Modeling

Example

signal in bit([31:0] Inport, // input ports
ignal in bit[1] Start

signal out bit([31:0] Outport, // output ports
signal out bit[1] Done)

void main (void)
{

£smd (CLK)
{
bit[32] a, b, ¢, d, e;

{ Outport = 0;
Done = 0Ob;
}
if (RST) { goto S0;
}
S0 : { if (Start) goto
else goto
}
Sl 3 {a=D>b+ c;

d = Inport * e;
Outport = a;
goto S2;

}

// clock + sensitivity
// local variables

// default
// assignments

// reset actions

Sl g
S0;

// state actions
// (register transfers)

}i

EECS222A: SoC Description and Modeling, Lecture 7
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The SpecC Language

F21'L behavior FSMD Example (
signal in bool CLK,
. signal in bool RST,
Modelmg signal in bit[31:0] Inport,
signal in bit[1] Start,
signal out bit[31:0] Outport,
Example signal out bit[1] Done)

void main (void)
{

// system clock
// system reset
// input ports

// output ports

fsmd (CLK; Inport, Start)

/

~

clock + sensitivity

}i

T
bit[32] a, b, ¢, d, e;

{ Outport = 0;

Done = 0Ob;
if (RST) ()goto S0;
SO : ()if (Start) goto
else goto
Sil g ()a =Db + c;

d = Inport * e;
Outport = a;
goto S2;

}

// local variables

// default
// assignments

// reset actions

Sig
S0;

// state actions
// (register transfers)
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EECS222A: SoC Description and
Modeling

The SpecC Language

RTL behavior FSMD Example (
signal in bool
. signal in bool
Modelmg signal in bit[31:0]
signal in bit[1]
signal out bit([31:0]
Example signal out bit[1]

CLK,
RST,
Inport,
Start,
Outport,
Done)

{ wvoid main (void)

// system clock
// system reset
// input ports

// output ports

‘ fsmd (CLK; RST)

// asynchronous reset

bit[32] a, b, ¢, d, e;

// local variables

d = Inport * e;
Outport = a;
goto S2;

}

}i

{ Outport = 0; // default
Done = 0b; // assignments
}
‘ if (RST) { goto SO; // reset actions
}
U8 { IT (Startj goto SI;
else goto SO;
}
S s {a=b+ c; // state actions

// (register transfers)
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The SpecC Language

F21'L behavior FSMD Example (
signal in bool CLK,
. signal in bool RST,
Modelmg signal in bit[31:0] Inport,
signal in bit[1] Start,
signal out bit[31:0] Outport,
Example signal out bit[1] Done)

{ wvoid main (void)
{
fsmd (CLK)
{
bit([32] a, b, ¢, d, e;

// system clock
// system reset
// input ports

// output ports

// clock + sensitivity

// local variables

{ Outport = 0;

// default

d = Inport * e;
Outport = a;
goto S2;

}

}i

Done = 0b; // assignments
1f (RST) 1}goto U7 Teset actions
SO : ()if (Start) goto S1;

else goto SO;
sl : ()a =Db + c; // state actions

// (register transfers)
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EECS222A: SoC Description and

Modeling

The SpecC Language

RTL behavior FSMD Example (
signal in bool CLK,
. signal in bool RST,
MOde“ng signal in bit([31:0] Inport,
signal in bit[1] Start,
signal out bit([31:0] Outport,
Example signal out bit[1] Done)

{ wvoid main (void)
fsmd (CLK)

bit[32] a, b, ¢, d, e;

// system clock
// system reset
// input ports

// output ports

// clock + sensitivity

// local variables

Outport = a;
goto S2;
}

}i

d = Inport * e;

{ Outport = 0; // default
Done = 0b; // assignments
}
if (RST) { goto SO; // reset actions
}
SO : { if (Start) goto S1;
else goto SO;
}
I8 {a =b F C;7

state actions

// (register transfers)
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The SpecC Language

RTL behavior FSMD Example (
signal in bool CLK,
. signal in bool RST,
Modelmg signal in bit[31:0] Inport,
signal in bit[1] Start,
signal out bit[31:0] Outport,
Example signal out bit[1] Done)

{ wvoid main (void)
{
fsmd (CLK)
{
bit([32] a, b, ¢, d, e;

{ Outport = 0;

// system clock
// system reset
// input ports

// output ports

// clock + sensitivity
// local variables

// default

Outport = a;
goto S2;
}

d = Inport * e;

Done = Ob; // assignments
if (RST) ()goto sS0; // reset actions
SO : ()if (Start) goto S1;

else goto SO;

S1 : (}a =b + c; // state actions

// (register transfers)

}i
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EECS222A: SoC Description and
Modeling

The SpecC Language

RTL
Modeling
Example

behavior FSMD Example (

signal in bool CLK, // system clock
signal in bool RST, // system reset
signal in bit[31:0] Inport, // input ports
signal in bit[1] Start,
signal out bit[31:0] Outport, // output ports
signal out bit[1] Done)
{ wvoid main (void)
£smd (CLK) // clock + sensitivity
L
bit[32] a, b, ¢, d, e; // unmapped variables
{ Outport = 0; // default
Done = 0b; // assignments
}
if (RST) { goto SO; // reset actions
}
S0 : { if (Start) goto S1;
else goto SO;
}
sl : {a=D>b+ c; // BAccellera style 1
d = Inport * e; // (unmapped)
Outport = a;
goto S2;

}

}i
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The SpecC Language

RTL
Modeling
Example

behavior FSMD Example (

}i

RE[3]=Inport*RF[4];//
Outport = RF[0];

goto S2;

}

signal in bool CLK, // system clock
signal in bool RST, // system reset
signal in bit[31:0] Inport, // input ports
signal in bit[1] Start,
signal out bit[31:0] Outport, // output ports
signal out bit[1] Done)
{ wvoid main (void)
{
fsmd (CLK) // clock + sensitivity
{
buffered[CLK] bit[32] RF[4]; // register file
{ Outport = 0; // default
Done = Ob; // assignments
}
if (RST) { goto SO; // reset actions
}
SO : { if (Start) goto S1;
else goto SO;
}
SN { RF[0]=RF[1]+RF[2]; // Accellera style 2

(storage mapped)
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EECS222A: SoC Description and

Modeling

RTL
Modeling
Example

The SpecC Language

behavior FSMD Example (

signal in bool CLK, //
signal in bool RST, //
signal in bit[31:0] Inport, //
signal in bit[1] Start,

signal out bit([31:0] Outport, //
signal out bit[1] Done)

{ wvoid main (void)

}i

system clock
system reset
input ports

output ports

£smd (CLK) // clock + sensitivity
{
buffered[CLK] bit[32] RF[4]; // register file
{ Outport = 0; // default
Done = 0b; // assignments
}
if (RST) { goto SO; // reset actions
}
SO : { if (Start) goto SI1;
else goto SO;
}
sl : { RF[0] = // Accellera style 3
ADDO (RF[1],RF[2]);// (function mapped)
RF[3] =

MULO (Inport,RF[4]);
Outport = RF[O0];
goto S2;

}

EECS222A: SoC Description and Modeling, Lecture 7

(c) 2009 R. Doemer 33

RTL
Modeling
Example

The SpecC Language

behavior FSMD Example (

signal in bool CLK, //
signal in bool RST, //
signal in bit([31:0] Inport, //
signal in bit[1] Start,

signal out bit[31:0] Outport, /7
signal out bit[1] Done)

{ wvoid main (void)

{

}i

system clock
system reset
input ports

output ports

fsmd (CLK) // clock + sensitivity
{
buffered[CLK] bit[32] RF[4]; // register file
bit[32] BUSO, BUS1, BUS2; // busses
{ Outport = 0; default
Done = Ob; // assignments
}
if (RST) { goto SO; // reset actions
}
SO : { if (Start) goto S1;
else goto SO;
}
&l s { BUSO = RF[1]; // Accellera style 4
BUS1 = RF[2]; // (connection mapped)
BUS3 = ADDO (BUSO,BUS1) ;

RF[0]= BUS3;

goto S2;
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Modeling

RTL
Modeling
Example

The SpecC Language

behavior FSMD Example (

}i

signal in bool CLK, // system clock
signal in bool RST, // system reset
signal in bit[31:0] Inport, // input ports
signal in bit[1] Start,
signal out bit[31:0] Outport, // output ports
signal out bit[1] Done)
void main (void)
£smd (CLK) // clock + sensitivity
L
signal bit[5:0] RF_CTRL; // control wires
signal bit[1:0] ADDO CTRL, MULO CTRL;
{ Outport = 0; default
Done = 0b; // assignments
}
if (RST) { goto SO; // reset actions
}
S0 : { if (Start) goto S1;
else goto SO;
}
sl { REF_ CTRL = 011000b; // Accellera style 5

}

ADBOJZTRL = 0lb; // (exposed control)
MULO_CTRL = 11b;

goto S2;
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